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About This Guide

Purpose

This manual describes the ICM-to-ICM Gateway functionality that is part of
Cisco’s Intelligent Contact Management (ICM) software. It discusses
ICM-to-ICM Gateway functionality, architecture, and call flows and provides
step-by-step instructions for configuring ICM systems for ICM-to-ICM Gateway
use.

Audience

This manual is intended primarily for system administrators who will be
responsible for configuring ICM systems for ICM-to-ICM Gateway use.

Conventions

This manual uses the following conventions.
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M Organization

Format Example

Boldface type is used for user Choose Edit > Find from the ICM
entries, keys, buttons, and folder |Configure menu bar.
and submenu names.

Italic type indicates one of the e A skill group is a collection of agents
following: who share similar skills.
e A newly introduced term ® Do not use the numerical naming

convention that is used in the
predefined templates (for example,
e A generic syntax item that persvc01).
you must replace with a
specific value

e For emphasis

e IF (condition, true-value, false-value)

e For more information, see the Cisco

e Atitle of a publication
ICM Software Database Schema

Handbook.
An arrow ( >) indicates an item | The Save command from the File menu is
from a pull-down menu. referenced as File > Save.

Organization

The manual is divided into the following chapters.

Chapter Description
Chapter 1, “ICM-to-ICM |Provides an overview of ICM-to-ICM Gateway
Gateway Overview” capabilities, gives examples of possible business

uses, discusses ICM-to-ICM Gateway links and
call flows, and states system requirements.

Chapter 2, “ICM-to-ICM |Describes the configuration tasks that you need to
Gateway Configuration” |perform on the Client ICM and the Server ICM in
order to enable ICM-to-ICM Gateway
functionality.
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Other Publications W

Other Publications

For additional information about Cisco Intelligent Contact Management (ICM)
software, see the Cisco web site listing ICM documentation.

Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. Cisco
also provides several ways to obtain technical assistance and other technical
resources. These sections explain how to obtain technical information from Cisco
Systems.

Cisco.com

You can access the most current Cisco documentation at this URL:
http://www.cisco.com/techsupport

You can access the Cisco website at this URL:
http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD

Cisco documentation and additional literature are available in the Product
Documentation DVD package, which may have shipped with your product. The
Product Documentation DVD is updated regularly and may be more current than
printed documentation.

The Product Documentation DVD is a comprehensive library of technical product
documentation on portable media. The DVD enables you to access multiple
versions of hardware and software installation, configuration, and command
guides for Cisco products and to view technical documentation in HTML. With
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M Obtaining Documentation

the DVD, you have access to the same documentation that is found on the Cisco
website without being connected to the Internet. Certain products also have .pdf
versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription.
Registered Cisco.com users (Cisco direct customers) can order a Product
Documentation DVD (product number DOC-DOCDVD=) from the Ordering tool
or Cisco Marketplace.

Cisco Ordering tool:
http://www.cisco.com/en/US/partner/ordering/
Cisco Marketplace:

http://www.cisco.com/go/marketplace/

Ordering Documentation

Beginning June 30, 2005, registered Cisco.com users may order Cisco
documentation at the Product Documentation Store in the Cisco Marketplace at
this URL:

http://www.cisco.com/go/marketplace/
Cisco will continue to support documentation orders using the Ordering tool:

e Registered Cisco.com users (Cisco direct customers) can order
documentation from the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

e Instructions for ordering documentation using the Ordering tool are at
this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

¢ Nonregistered Cisco.com users can order documentation through a local
account representative by calling Cisco Systems Corporate Headquarters
(California, USA) at 408 526-7208 or, elsewhere in North America, by
calling 1 800 553-NETS (6387).

l  'CM-to-ICM Gateway User Guide for Cisco ICM Enterprise & Hosted Editions Release 7.0(0)



http://www.cisco.com/en/US/partner/ordering/
http://www.cisco.com/go/marketplace/
http://www.cisco.com/go/marketplace/
http://www.cisco.com/en/US/partner/ordering/
http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

| About This Guide

Documentation Feedback

Documentation Feedback

You can rate and provide feedback about Cisco technical documents by
completing the online feedback form that appears with the technical documents
on Cisco.com.

You can send comments about Cisco documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front
cover of your document or by writing to the following address:

Cisco Systems

Attn: Customer Document Ordering
170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview

Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

From this site, you can perform these tasks:
e Report security vulnerabilities in Cisco products.
e Obtain assistance with security incidents that involve Cisco products.
e Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at
this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you
can access a Product Security Incident Response Team Really Simple Syndication
(PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html
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Reporting Security Problems in Cisco Products

Tip

Cisco is committed to delivering secure products. We test our products internally
before we release them, and we strive to correct all vulnerabilities quickly. If you
think that you might have identified a vulnerability in a Cisco product, contact
PSIRT:

¢ Emergencies—security-alert@cisco.com

An emergency is either a condition in which a system is under active attack
or a condition for which a severe and urgent security vulnerability should be
reported. All other conditions are considered nonemergencies.

e Nonemergencies—psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:
e 1877 228-7302
e 1408 525-6532

We encourage you to use Pretty Good Privacy (PGP) or a compatible product to
encrypt any sensitive information that you send to Cisco. PSIRT can work from
encrypted information that is compatible with PGP versions 2.x through 8.x.

Never use a revoked or an expired encryption key. The correct public key to use
in your correspondence with PSIRT is the one linked in the Contact Summary
section of the Security Vulnerability Policy page at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
m

The link on this page has the current PGP key ID in use.

Obtaining Technical Assistance

Cisco Technical Support provides 24-hour-a-day award-winning technical
assistance. The Cisco Technical Support & Documentation website on Cisco.com
features extensive online support resources. In addition, if you have a valid Cisco
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Obtaining Technical Assistance

service contract, Cisco Technical Assistance Center (TAC) engineers provide
telephone support. If you do not have a valid Cisco service contract, contact your
reseller.

Cisco Technical Support & Documentation Website

Note

The Cisco Technical Support & Documentation website provides online
documents and tools for troubleshooting and resolving technical issues with Cisco
products and technologies. The website is available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website
requires a Cisco.com user ID and password. If you have a valid service contract
but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Use the Cisco Product Identification (CPI) tool to locate your product serial
number before submitting a web or phone request for service. You can access the
CPI tool from the Cisco Technical Support & Documentation website by clicking
the Tools & Resources link under Documentation & Tools. Choose Cisco
Product Identification Tool from the Alphabetical Index drop-down list, or click
the Cisco Product Identification Tool link under Alerts & RMAs. The CPI tool
offers three search options: by product ID or model name; by tree view; or for
certain products, by copying and pasting show command output. Search results
show an illustration of your product with the serial number label location
highlighted. Locate the serial number label on your product and record the
information before placing a service call.

Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4
service requests. (S3 and S4 service requests are those in which your network is
minimally impaired or for which you require product information.) After you
describe your situation, the TAC Service Request Tool provides recommended
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solutions. If your issue is not resolved using the recommended resources, your
service request is assigned to a Cisco engineer. The TAC Service Request Tool is
located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the
Cisco TAC by telephone. (S1 or S2 service requests are those in which your
production network is down or severely degraded.) Cisco engineers are assigned
immediately to S1 and S2 service requests to help keep your business operations
running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has
established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your
business operations. You and Cisco will commit all necessary resources around
the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or
significant aspects of your business operation are negatively affected by
inadequate performance of Cisco products. You and Cisco will commit full-time
resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most
business operations remain functional. You and Cisco will commit resources
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product
capabilities, installation, or configuration. There is little or no effect on your
business operations.
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Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is
available from various online and printed sources.

Cisco Marketplace provides a variety of Cisco books, reference guides,
documentation, and logo merchandise. Visit Cisco Marketplace, the company
store, at this URL:

http://www.cisco.com/go/marketplace/

Cisco Press publishes a wide range of general networking, training and
certification titles. Both new and experienced users will benefit from these
publications. For current Cisco Press titles and other information, go to Cisco
Press at this URL:

http://www.ciscopress.com

Packet magazine is the Cisco Systems technical user magazine for
maximizing Internet and networking investments. Each quarter, Packet
delivers coverage of the latest industry trends, technology breakthroughs, and
Cisco products and solutions, as well as network deployment and
troubleshooting tips, configuration examples, customer case studies,
certification and training information, and links to scores of in-depth online
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

iQ Magazine is the quarterly publication from Cisco Systems designed to
help growing companies learn how they can use technology to increase
revenue, streamline their business, and expand services. The publication
identifies the challenges facing these companies and the technologies to help
solve them, using real-world case studies and business strategies to help
readers make sound technology investment decisions. You can access iQ
Magazine at this URL:

http://www.cisco.com/go/igmagazine
or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoig/sample/
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e Internet Protocol Journal is a quarterly journal published by Cisco Systems
for engineering professionals involved in designing, developing, and
operating public and private internets and intranets. You can access the
Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

e Networking products offered by Cisco Systems, as well as customer support
services, can be obtained at this URL:

http://www.cisco.com/en/US/products/index.html

e Networking Professionals Connection is an interactive website for
networking professionals to share questions, suggestions, and information
about networking products and technologies with Cisco experts and other
networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

e  World-class networking training is available from Cisco. You can view
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html
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CHAPTER 1

ICM-to-ICM Gateway Overview

This chapter provides an overview of ICM-to-ICM Gateway. It discusses the
following topics:

e Business uses for ICM-to-ICM Gateway

e The ICM-to-ICM Gateway link

e ICM-to-ICM Gateway call flows

¢ ICM-to-ICM Gateway fault tolerance capabilities

¢ ICM-to-ICM Gateway system and network configuration requirements

What is ICM-to-ICM Gateway?

ICM-to-ICM Gateway extends the ICM software capability by allowing agents to
simultaneously post-route calls and supply additional call-related information to
a second agent on a different ICM. This enables the initial agent to pass on
gathered information without the customer’s needing to repeat it to the second
agent.

Following are some business scenarios where ICM-to-ICM Gateway functionality
can be particularly useful.

e A customer calls the institutional department of a financial corporation for
customer service assistance with a company-sponsored 401k. The customer
then asks to be transferred to the retail department to obtain assistance with a
personal account.
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e Two corporations (for example, a bank and an insurance company), each of
which has a contact center that uses an ICM, merge. It may often be desirable
to transfer a call between the two companies; for example, to sell insurance
to a bank customer.

e A customer calls a hotel to make a reservation. The hotel agent then asks the
customer if he/she also needs to rent a car, and then transfers the customer to
a car rental agent.

e A company uses an outsourcer to handle part of its overflow traffic. For
example, the company service department handles paid support calls in-house
but transfers warranty service requests to the outsourcer.

e A multi-national corporation encompasses several geographic regions; each
geographic region has its own ICM.

In all these cases, ICM-to-ICM Gateway enables the call-related data to be
transferred along with the call so the customer does not need to supply this
information again.

ICM-to-ICM Gateway Call Flow

Figure 1-1 illustrates basic ICM-to-ICM Gateway call flow.

Figure 1-1  Basic ICM-to-ICM Gateway Call Flow
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Step 1

Step 2

Step 3

Step 4

ICM-to-ICM Gateway Call Flow

A Client ICM receives a request. This could be a pre-route request from a service
provider network (in which case the routing client is a NIC) or a post-route
request from an ACD/IVR (in which case the PG acts as the routing client)

The Client ICM executes a script. At some point the script initiates a route request
to the other ICM, referred to as the Server ICM. At this point the Server ICM must
find a destination label for the call.

The Server ICM executes a script to select a destination label for the call. The
Server ICM handles this call as a normal route request, save for the fact that the
routing client is another ICM and not a service provider network or an ACD/IVR.
Once a destination label is selected the Server ICM sends it back to the Client
ICM.

When the Client ICM receives the destination label from the Server ICM, it passes
the label directly to the routing client that initiated the route request. This does
not happen under script control, but is an automatic process.

ICM-to-ICM Communication

The ICM-to-ICM Gateway link connects two ICMs through a Cisco proprietary
protocol called INCRP (Intelligent Network Call Routing Protocol). Both ICMs
have a component managing the connection.

The component on the Client ICM is called an ICM Gateway. It sends the route
requests and receives the responses (destination labels) from the Server ICM.

The component on the Server ICM is called an INCRP Network Interface
Controller (INCRP NIC). The NIC receives route requests and sends responses
back to the requester. An ICM can have an INCRP NIC, as well as other types of
NICs.

Both the ICM Gateway and the INCRP NIC are components that run on the Router
machine, so no additional hardware is required.
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Figure 1-2  ICM-to-ICM Link Components
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The ICM-to-ICM link shown in Figure 1-2 is a connection in one direction only.
It allows the Client ICM to send route requests to the Server ICM, but not the other
way around. It is possible to additionally reverse the roles of the ICMs as well, so
that each ICM can send route requests to each other. In this case, each ICM needs
an ICM Gateway and an INCRP NIC, as shown in Figure 1-3.

Figure 1-3  Bi-Directional ICM-to-ICM Link

1Ch G ateway INCRP MIC
Route Reguest i
—— =
-
Route R
Route Requoet =
- O
= Ol
Route Response /’”fﬂ -

IMNCRF MIC ICM Gateway

INCRP supports direct connections between two ICMs only. ICMs that are not
directly connected with an ICM-to-ICM link cannot send each other route
requests through another ICM.
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Pre-Routing

Figure 1-4 illustrates a call flow scenario for a call that is pre-routed from one
ICM to another.

Figure -4 Example Pre-Routing Call Flow

S
Client 2. ‘ecrxner

ICM
ACD 3.

PG - ACD
PG 1.

Service
Provider
Network

Step 1 The Service Provider network sends a route request to the Client ICM.

Step2  The Client ICM receives the pre-route request and executes a routing script that
determines that the route request is to be handed to another ICM. The ICM
forwards the route request to the Server ICM.

Step3  The Server ICM executes a script that selects a peripheral target for the call and
sends the corresponding label to the Client ICM.

Step4  If the selected target is reached using a translation route, the Server ICM sends the
call context data to the selected peripheral, where it waits for the call to arrive. If
translation routing is not used, this step is skipped.

Step5 The Client ICM forwards the destination label (that it received in Step 3) to the
network.

Step6  The network connects the call to the selected destination on the Server ICM
ACD/Agent.
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Step 7 If this was a translation routed call, the ACD connected to the Server ICM
requests the call detail information from the PG where it has been waiting since
Step 4 and sends the call to an agent.

Post-Routing

Figure 1-5 illustrates a call flow scenario for a post-routed call transfer from one
ICM to another.

Figure 1-5 Example Post-Routing Call Flow
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Step 1 A call terminates at an ACD that is connected to the Client ICM. This can be a
pre-routed call or a call sent there without ICM control.

Step2  The agent initiates a post-route request in one of two ways:

a. The agent transfers the call to a special number on the ACD, which prompts
the ACD to issue a post-route request to the Client ICM.

b. The agent sends a call transfer request to the CTI Server (not shown). This
transfer request must have the post-route flag set, so that a post-route request
is issued to the Client ICM before transferring the call.
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Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Logical Connection Management and Fault Tolerance

The Client ICM receives the post-route request along with the call context and
runs a scheduled script that determines that the route request is to be handed to
the Server ICM. The Client ICM forwards the route request to the Server [CM.

The Server ICM selects a destination for the call and responds back to the Client
ICM with the selected label. The Server ICM also returns the (possibly modified)
call context to the Client ICM.

The Client ICM receives the label, attempts to validate it, and passes the label onto
its routing client (the PG in this case). If no label is received from the Server ICM
(or the Server ICM is not online) the Client ICM provides a destination label and
sends it to the routing client.

If the selected target was a peripheral target with an associated translation route,
the Server ICM sends the translation route information to the PG, where the ACD
waits until the call arrives at the ACD and the ACD retrieves the information from
the PG (in Step 8). If the selected target does not use a translation route, this step
is skipped. In that case, the call context is still transferred to the Server ICM but
it is not available for the receiving ACD, since it cannot be matched with the call.

The original PG and the ACD transfer the call to its destination. The PG sends the
destination label to the ACD. The ACD uses that information to disconnect the
agent who requested the call transfer and connects the incoming call leg to its
destination using a tie line or public network trunk.

If this is a translation route call, the ACD connected to the Server ICM receives
the call, requests the call detail information from the PG (where it has been
waiting since Step 6), and sends the call to an agent.

Logical Connection Management and Fault Tolerance

Because the ICM software is typically deployed as a synchronous duplex pair, the
ICM-to-ICM Gateway is likewise deployed between ICM system pairs. This
leverages the ICM software’s fault tolerant architecture and keeps the
synchronous router pairs in sync.

ICM-to-ICM Gateway addresses the following other possible points of failure as
follows:
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¢ Inthe case of a link failure, each INCRP NIC has a link to both ICM Gateway
components. Each INCRP NIC can therefore maintain communications with
the other ICM Gateway.

Failed Link

. —
\‘\-\_\_ Seprer ICM &

. INCRF MG

—1
CllanptizmMa SeneriCwl B

e If an INCRP NIC fails, the Client ICM’s routers are synchronized and can
communicate via the remaining INCRP NIC.
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Logical Connection Management and Fault Tolerance
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>
Note  If a link failure or a NIC failure occurs, calls that were in progress at the time of
the failure may be lost.

e If an ICM-to-ICM Gateway fails, the Server ICM’s routers are synchronized
and can communicate via the remaining ICM-to-ICM Gateway.
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For a more complete discussion of ICM Fault Tolerance, refer to the ICM
Administration Guide for Cisco ICM Enterprise Edition.

ICM-to-ICM Gateway Requirements

The following are system requirements for [CM-to-ICM Gateway.

Both Client ICM and Server ICM require ICM software version 4.5.1 or later.
If two connected ICMs are running different versions of ICM software, only

the ICM-to-ICM Gateway features supported by the lowest numbered version
are available.

An ICM communication network configuration that can support ICM-to-ICM
Gateway. The Signaling Access Network (SAN) is strongly recommended,
with the private network as an alternate if a SAN does not exist.

l  'CM-to-ICM Gateway User Guide for Cisco ICM Enterprise & Hosted Editions Release 7.0(0)




| Chapter1 ICM-to-ICM Gateway Overview

ICM-to-ICM Gateway Requirements

A
Note Refer to the Pre-Installation Planning Guide for Cisco ICM

Enterprise Edition for information about the Signaling Access
Network and ICM communications network configurations.

ICM-to-ICM Gateway User Guide for Cisco ICM Enterprise & Hosted Editions Release 7.0(0) g



Chapter1  ICM-to-ICM Gateway Overview |

Il ICM-to-ICM Gateway Requirements

l  'CM-to-ICM Gateway User Guide for Cisco ICM Enterprise & Hosted Editions Release 7.0(0)




Note

CHAPTER

ICM-to-ICM Gateway Configuration

This chapter includes instructions for the various tasks that you need to perform
on the client and server systems in order for ICM-to-ICM Gateway to function
correctly. For the Client ICM, these tasks include the following:

e Configuring an ICM Gateway process on the Router.
e Define Client ICM configuration data.

e Making the necessary script changes for sending pre-route or post-route
requests to the Server ICM.

e Optionally, specifying a fixed local port number for the Network CIC
process.

L]

For the Server ICM, these tasks include the following:
¢ Installing and Configuring an INCRP NIC on the Router.
e Setting up the necessary translation route labels.

e Making the necessary script changes for returning calls and labels to the
Client ICM.

If you are implementing a bidirectional ICM-to-ICM Gateway link (see
Chapter 1, “ICM-to-ICM Gateway Overview”), you need to perform Client side
configuration and Server side configuration on both ICM systems.
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Client ICM Configuration

This section provides instructions for the configuration tasks you need to perform
on the Client ICM.

Identify the Client for the Server

To identify the ICM Gateway Client for the ICM Gateway Server, run a full ICM
Setup on the Client Router machine. For each ICM-to-ICM Gateway client, you
must perform the following steps.

Step1  In the Router Properties screen, check the Remote Network Routing option box.

Router Propertias

[
[
[]
[

1

Step2  Specify a NAM ID (Client ICM ID) number in the NAM ID box provided.
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e If this Client ICM is the only Client ICM that will be communicating with its
associated Server ICM, accept the default of 0.

e If the associated Server ICM will be communicating with multiple Client
ICMs, the NAM ID needs to be a unique number for each Client ICM in the
configuration. In this case, start NAM ID numbers from 0 and work upwards.

Note = Make a note of the NAM ID number that you specify for the client. You will need
to specify this same NAM ID number during Server side configuration.

For more information on router installation, refer to the ICM Installation Guide
for Cisco ICM Enterprise Edition.

Defining Client ICM Configuration Data

In a two-tier architecture, the Client ICM system requires only a subset of the
normal ICM configuration data. Table 2-1 summarizes the configuration data for

a Client ICM.

Table 2-1  Configuration Data on a Client ICM

Table

Contents

Announcement

Any announcements used in Client ICM scripts.

Application Gateway

A remote ICM gateway for each instance on each
associated Server ICM.

Business Entity

The default business entity only.

Call Type Typically, one for each instance.

Call Type Map Associate each Client ICM call type with a Client
ICM script.

Dialed Number All dialed numbers used on associated Server

ICMs, plus those used for direct translation. (No
default routes are defined for Client ICM dialed
numbers.)

ICM-to-ICM Gateway User Guide for Cisco ICM Enterprise & Hosted Editions Release 7.0(0) g



Chapter2  ICM-to-ICM Gateway Configuration |

M Defining Client ICM Configuration Data

Table 2-1  Configuration Data on a Client ICM

Table Contents

Dialed Number Map Associates dialed numbers and calling line IDs with
Client ICM call types.

Label All labels that can be returned by associated Server

ICMs, plus those used for direct translation.

Network Interface
Controller

One required for the Network Interface Controller
to the carrier network.

Peripheral Gateway (PG)

One or more for the Peripheral Gateway to the
carrier network.

Prefix

Any prefixes used in Client ICM regions.

Region

Any regions used in Client ICM dialed number
map.

Routing Client

One or more for the carrier network.

Script

One or more for each call type.

The Client ICM needs only a limited configuration (dialed numbers, labels, basic
routing scripts, etc.) while the instance-specific scripts, configuration, real-time,
and historical data are stored on the Server ICM.

To set up your Client ICM configuration, run Configuration Manager on a Client

ICM Admin Workstation.

For instructions on using Configuration Manager, refer to the ICM Configuration
Guide for Cisco ICM Enterprise Edition.

Create or Configure the Gateway Process on the Router

An Application Gateway process must be configured on the Client ICM for each
Server ICM that the Client ICM is going to communicate with.

l  'CM-to-ICM Gateway User Guide for Cisco ICM Enterprise & Hosted Editions Release 7.0(0)



| Chapter2 ICM-to-I

CM Gateway Configuration

Configuring A

Defining Client ICM Configuration Data Il

New Gateway

If you need to configure a new Application Gateway, perform the following steps.

Step1  From the ICM Configuration Manager on an Admin Workstation associated with
the Client ICM, select Calls > Application Gateway > Application Gateway
List. The Application Gateway List window appears.
Step2  Click Retrieve.
Step3  Click Add. The Attributes tab appears.
x: Application Gateway List _|_|- jm ] Ll
Select fiter data Attributes | Connection SideAI Cormection Side B
MName *I
Optional Filter Condition Walue Application gateveay 1D ID
INone j I j I j Type ‘W
I~ Save Eetrieve | Cancel filter changes | Prefoned side lm
el EeErp Encryption *|<Nona> hd
Mame
L
Connection I Duplex 2
Description |
Delete Fewert Save Close Help
|ICM Instance: custl
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Step4  Specify the following values on the Attributes tab:

Name. Enter a name for the ICM Gateway.
Type. Choose Remote ICM.

Preferred Side. Indicates the preferred side of the Gateway to use when both
are available. If only one side is available, ICM software uses that side
regardless of preference.

Encryption. Indicates whether requests to the Application Gateway are
encrypted. Choose None.

Fault Tolerance. If the Application Gateway is duplexed, specifies the
fault-tolerance strategy it uses. Choose None.

Connection. Choose whether the Gateway is Duplex (has both a Side and
Side B connection), Simplex A (only has a Side A), or Simplex B (only has a
Side B).

Description. (Optional.) Additional information about the gateway.

Step5  Click the Save button to create the gateway.

N

Note

Make a note of the Application Gateway ID value, as you will need it
when you run Setup to configure the INCRP NIC on the Server ICM.

Step6  To set the connection information, click on the Connection Side A tab or the
Connection Side B tab.

Step7  To specify an address, click on the Enter Address button. The Enter NAM
Addresses dialog box appears.
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—Mak Mode
(ol " Multiple Makds
—Address
IP Addrese/Mame Instance Mumber Side
I IU INDne j
Address List
IP Address!Namel Ihstance Numberl Side | HAaM 1D | Add |
Update |
Bemove |
[k I Cancel Help

Step8  Specify the following information:

NAM Mode. Select Single NAM.

IP Address/Name. Enter the high priority IP address of the Server ICM.
(Normally this is the public IP address, but if no public address is available,
use the high priority private IP address.) This address must be the same
address specified for the INCRP NIC on the targeted system. (You may use
the hostname in place of the address.)

Instance Number. Enter the number of the customer ICM on the Server ICM

(0 through 24).

Side. Indicate which side of the Client ICM prefers this connection:

— Side A. Client ICM Side A prefers to use this connection.

- Side B. Client ICM Side B prefers to use this connection.

— None. Neither side of the Client ICM prefers to use this connection.
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- Both Side A and B. Both sides of the Client ICM prefer to use this
connection.

)

Note  Consider network traffic in choosing this value. For example, if one side
of the Client ICM is co-located with only one side of the Server ICM, you
can make that the preferred connection in order to avoid unnecessary
WAN traffic to the other side.

Step 9 When finished, click Save to save the changes.

Step10 From the Application Gateway list, make note of the Application Gateway IDs
number(s) for the server system(s). You will need to specify these Application
Gateway ID number(s) during Server side configuration.

The bottom half of the ConnectionSide A and Connection Side B tabs display a
number of timeout and limit values. Accept the defaults for these values.

Configuring an Existing Gateway

If the gateway process is already present on the Router, perform the following
steps to configure it for ICM-to-ICM Gateway use.

Step 1 Bring up the Calls > Application Gateway > Application Gateway List screen.
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=y Application Gateway List P ] 3
Select fiter data Attributes | Connection Side AI Connection Side B
Mame *I
Optional Fiker Conditian Value Application gateway 1D IU
INone =l | | | =] Type *|Remate 1CM =
™ Save Betrieve | Cancel files changes | Preferred side ISideA 'I
—Application G
CEFEI SR Encryption *|<None> 'I
Mame
Fault tolerance l I <Moner 'l
Cannection IDupIax < I
Description I

LDelete Fievert

Save Cloze Help

|ICM Instance: custl

Step2  Click Retrieve.

Step3  From the Application Gateway list, make note of the Application Gateway IDs
number(s) for the server system(s). You will need to specify these Application
Gateway ID number(s) during Server side configuration.

Step4  Configure the Connection Side A and Connection Side B tabs as needed. Refer to
the ICM Scripting and Media Routing Guide for Cisco ICM/IPCC Enterprise &
Hosted Editions for instructions.

Step5  Bring up the Enterprise > System Information Screen.
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Step6  In the Application Gateway section, click on Remote ICM. Accept the default
values for the remaining fields on all tabs.

Bprbe-abir [l
Timeout | Smesions | Hesiibeats | Exors |
" Custom galewy
= F‘."".'"’Ef':” Fiinzud =00 _II-| ki orals
Ahangon | 000 _I:I rrilizecrrals
Late 400 _l;l rilisecorads

Configuring ICM Instances on the Client ICM

Perform the following steps on the Client ICM system to configure the associated
Server ICM instance.

Step1  Start Configuration Manager from the ICM Admin Workstation group. The
Configuration Manager window opens.

Step2  Open the ICM Instance List tool (Enterprise > ICM Instance > ICM Instance
Explorer). The ICM Instance List window appears.

Step3  Click the Retrieve button.
Step4  Click the Add ICM Instance button.
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i » ICM Instance Explorer - IEllzl
Select filter data
ICM Instance | ICM Nodel
MName: *I
Optional Filter Condition WValue Type: *I j
INone j I j I j Instance number * ID
[ Save Eetrieve | Cance| filter changes | Network ICM instance I j
D escription: I
LI Hide legend
859 (1)ICH Instance
2 [2) Customer definition
Click on an item to edit or view its contents.
Usze the Add buttons to create new items.
cList]
| Delete  |== Multiple...
L L
2 [2] Add Customer definition Bee Close Help
|ICM Instance: custi

Step5  Specify the following on the ICM Instance tab:
e Name. The enterprise name for the Client ICM instance, as used in Setup.
e Type. (Drop-down list.) Select Network ICM.
¢ Instance Number. The instance number as defined in Setup.

e Description. (Optional.) Additional information about the ICM Instance.

Step6  Click Save.
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Step 7
Step 8

Step 9

Client Script

Step 1

Step 2

Click the Add ICM Instance button.

Specify the following on the ICM Instance tab:
¢ Name. The enterprise name for the Server ICM instance, as used in Setup.
¢ Type. (Drop-down list.) Select Customer ICM.
e Instance Number. The instance number as defined in Setup.

¢ Network ICM Instance. (Drop-down list.) The associated Client ICM
instance configured in Step 5.

¢ Description. (Optional.) Additional information about the ICM Instance.

Click Save.

Typically, the client ICM originally receives the call and pre-routes it to an ACD.
The call is then post-routed to a peripheral associated with the server system. The
client determines the label associated with the server’s peripheral by requesting
the label from an ICM Gateway node in a script.

From the Script Editor, you can specify a local definition of the label that the ICM
Gateway node returns. Perform the following steps:

Right click on the ICM Gateway node.

)

ICM Gateway

[Zh Customer2

X

From the pop—upmenu that appears, choose Properties. The ICM Gateway dialog
box appears.
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P73 ICM Gateway Properties

Step3  From the list, select the gateway to the ICM system to which you want to send the
request.

Step4  Check the Validate Returned Labels check box if you want the Client ICM to
validate the label that the Server ICM returns before passing it to the routing
client. If the Server ICM is returning a dynamic label (an expression the Server
ICM CallRouter converts to a character string and returns to the routing client as
a label), do not check this box.

Step5  On the Default Label tab, specify a default label to be used if the Server ICM
returns an invalid label.

Step6  Click OK.
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Specifying a Fixed Local Port Number for the NetwrkCIC Process

In an ICM-to-ICM Gateway implementation, the NetwrkCIC process is a part of
the Client ICM Router installation that manages the ICM Gateway. By default, the
IP port used in the NetwrkCIC process for the public network communication to
the Server ICM INCRP NIC process is selected dynamically at runtime.

ICM processes use IP port numbers between 39000 and 50000. Use the following
formula to obtain the number for side A of a duplexed system

Port number = 40000 + (i * 40) + 33

where i is the instance number of an ICM instance. To find out the instance
number, run the local setup program, select an instance and click the edit button.
The “Edit Instance” dialog box will display the instance number.

For instance number 0, the port number will be 40033.

For side B, the port number is obtained by adding 1000 to the above number. This
formula is intended to be stable. However, there is no guarantee that the formula
will not change.

This dynamic port allocation is an issue for some ICM customers. You can
optionally modify the NetwrkCIC process to use a specific port number. If a
specific port number is provided in the registry of the Client ICM machine, the
NetwrkCIC process will instead bind to that port number when communicating
with the server INCRP NIC process.

To specify this port number, add the following registry entry on the Client ICM
machine:

HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<instance
name>\Router [A,B]\CIC\CurrentVersion\Configuration\CIC Public LAN IP
Port

Specify this entry as a DWORD type.

This registry entry is not managed by the ICM Setup program. Therefore if you
upgrade ICM software later, you must add the registry entry again.

If the registry entry is not present, the NetwrkCIC process uses the port
dynamically allocated as usual.

If you change the port number while the NetwrkCIC process is running, you must
restart the ICM router service for it to take effect.
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This section provides instructions for the configuration tasks you need to perform
on the Server ICM.

Defining and Configuring the INCRP NIC

To set up the INCRP NIC for each instance on the Server ICM, you must perform
the following tasks:

e Install the INCRP NIC, if you have not already done so
¢ Define the INCRP NIC using the NIC Explorer tool
e Add INCRP NIC information using ICM Setup

Installing the INCRP NIC

If you need to install the INCRP NIC, refer to the ICM Installation Guide for
Cisco ICM Enterprise Edition for guidelines and procedures.

How to Define the INCRP NIC

Step1  Within the ICM Admin Workstation group, double-click AW Select. The Select
ICM AW Service window appears.

Step2  Select the instance you will be configuring.

Step3  From the ICM Configuration Manager, invoke the NIC Explorer tool. The NIC
Explorer window appears.

Step 4 In the Select filter data box, click Retrieve. This enables the Add NIC button.

Step5  Click Add NIC. A new NIC and its routing client display in the tree window. Next
to each is a To Be Inserted icon.

On the right of the tree window, tabbed fields also display the new NIC’s and
routing client’s configuration information.

Step6  Enter the following in the Logical Interface Controller tab fields:
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e Name. A name that will serve as the NIC name. The name can be up to 32
characters. The valid characters are upper-case and lower-case letters, digits,
periods (.) and underlines (_). The first character of the name must be a letter
or digit.

¢ Client Type.(Drop-down list.) The type of routing client serviced by the
NIC. Select INCRP.

~

Note  Selecting a type of routing client automatically places that type’s
default values in the Routing Client’s Timeout Threshold, Late
Threshold, Timeout Limit, Use DN/Label Map, and Client Type
fields.

Logieal Ireerface Conoler | Phyrcd Inimface Coraler |

Carirolhe 10 » UNASSIEHED
Harnz: wl
Cligrk twpe: *l ﬂ

Corfiguration paiamste: |

Diezciintion: |

iy vl e ool = |

Step7  Click the Add Physical Interface Controller button. The Physical Interface
Controller dialog box appears.
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Step8  In the Create Single Physical Interface Controller section, specify an Enterprise
Name and, optionally, a Description.

Step9  Click OK. The Physical Interface Controller tab appears, displaying the
information you specified, and an ID value of UNASSIGNED.

Step10  Enter the following information in the Routing Client tab fields:

e Name. A name that will serve as the NIC Routing Client name. The name can
be up to 32 characters. The valid characters are upper-case and lower-case
letters, digits, periods (.) and underlines (_). The first character of the name
must be a letter or digit.

¢ Timeout threshold. The maximum time, in milliseconds, the routing client
can wait for a response to a routing request. The NIC sends a default response
slightly before this threshold.

¢ Late threshold. A threshold value, in milliseconds, for classifying responses
as late. Any response that exceeds this threshold is considered late even if it
does not exceed the Timeout Threshold.

e Timeout limit. The maximum time, in seconds, for which the routing client
waits for a response. This is the maximum time the routing client will tolerate
consecutive response timeouts before it stops sending requests to the ICM
software. If the routing client receives no responses from the ICM software
within this limit, it terminates routing operation.
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¢ Client Type.(Drop-down list.) The type of routing client that ultimately
routes the call on the requesting ICM system. This must match the type of
NIC running on the Client ICM.

R auting Client
Routing client ID: * 5000
Mame: * |INCRP_1_RLC
Timeout threshold: = 1000
Late threshald: * |5|:||:|
Tirneaut limnit: % |'| 0
Default call type: I HOME j
Canfiguration
parameters: I
Usze DM/Label map; [
Client type: * I CR3F j
Descriptior: I
I etwark: routing client: I
g doma |NONE =~

Step11  Click Save. The newly defined NIC is saved in the database, a Physical Controller
ID is assigned, and the To Be Inserted icon is removed from the tree window.

>

Note  Make a note of the Physical Controller ID value. You need this value
to set up the INCRP NIC on the CallRouter. If the NIC is duplexed,
you need both Physical Controller ID values.

Step12  Click Close to exit the NIC Explorer.
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Configuring the INCRP NIC in ICM Setup

To configure the INCRP NIC on the Server ICM, run ICM Setup and edit the
Router from the Server Router machine (rather than from the installation CD).
Perform the following steps.

Step1  On the Router Component Properties screen, click the INCRP check box.
Step2  Click on the Configure button. The INCRP NIC Properties screen appears.

INCRF MIC Propestie:

4]

ICM Setup supports a maximum of ten clients.

Step 3 In the Network Interface Controller section of this screen, ensure that the value
for Physical Controller matches the Physical Controller ID value that was
assigned to the NIC when you defined the NIC (see the previous section,
“Installing the INCRP NIC”).
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Step 4 In the Client ICM section of this screen, enter the following information for each
client for which this system is a server.

Enable. Check the Enable box to enable the client.
Description. Enter a description of the client (optional).

Client ID. Enter the same value that you entered for NAM ID during client
machine router setup on the Router Properties screen (see the “Identify the
Client for the Server” section on page 2-2).

Application Gateway ID. Enter the application gateway ID. This must
match the application gateway ID as shown on the Calls > Application
Gateway All list screen (see the “Create or Configure the Gateway Process on
the Router” section on page 2-4).

Side A Address, Side B Address. If you are using the Signaling Access
Network, enter the Signaling Access Network IP address for the client.
Otherwise, enter the Public Network IP address.

Step5 Click OK.

Setting Up Translation Route Labels

From the ICM-to-ICM Gateway server’s point of view it is doing a translation
route to one of its peripheral targets. When you set up a translation route on the
Server ICM, you must set up a label for the original routing client for a call to
access each of the peripheral targets associated with the translation route. For
example, if the routing client is an interexchange carrier (IXC), you must set up a
label to the targets with the IXC. This allows the call to be initially sent to the
translation route at the peripheral.

For instructions on how to run Translation Route Wizard and how to define
translation route labels, refer to the ICM Configuration Guide for Cisco ICM
Enterprise Edition.
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Modifying Routing Scripts

The server has a script that handles requests from the client. The script is
associated with a call type, which is in turn defined by the dialed number, calling
line id, and caller entered digits.

From the Script Editor, you can specify the label that the server script returns to
the client. For example, you could create a Select node that routes calls to
specified services under certain conditions. Perform the following steps.

Step 1 From Script Editor, connect the Select node to a Service node.

Step2  Right click on the Select node and choose Properties. The dialog box appears.

4 Select Properties

Longest Available Agent |_
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Step3  Specify the criteria for selecting services.

Note  You can specify the label that the server script returns from other Script Editor
nodes, such as the Label node. Refer to the ICM Scripting and Media Routing
Guide for Cisco ICM/IPCC Enterprise & Hosted Editions for more information.
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